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I ntroduction

A process flowsheet describes the
sequence of unit operations that are
performed in a coa preparation plant. The
flowsheet (or any part of the flowsheet) can
be represented using a series of nodes and
dreams. A node represents a  unit
operation as ether a junction (two streams
which combine to form a single stream) or
Separator (one stream that is separated in
two streams). A series of materia balance
expressons can be constructed for each
node in the flowsheet. For example,
consder the following expressons for a
smple separator:

F=C+T
Ff=Cc+Tt

where F, C and T are the respective mass
flow raes of the feed, concentrate and
tallings sreams and f, ¢ and t are the
respective assays which represent the
content of a given component in these
sreams. Usng these bdances, an
expression for concentrate yield (Y) can be
derived as:

Y = 100 (C/F) = 100(t-f)/(t-¢)

This expresson is known as the two-
product formula.  Usng this formula, the
mass flow rates of the concentrate (C) and
talings (T) dreams can be cdculated
provided that the feed stream mass flow (F)
and al assays (f, c and t) are known.

A common problem in usng the two-
product formula is that a unit operation (or
combined group of operations) is often
overdefined, i.e., multiple sets of assays are
available which can be independently used
to cdculate the yidd. For example,
common assay vaues for cod include ash,
sulfur, Btulb, eic. As with mogt
experimentad programs, there is some
degree of error associated with the data
collection  procedures. Thus, the
experimental assays will often provide
different estimates of the flow rates.

Two solutions are possible to resolve
this ambiguity. One would be to ignore
some of the measured data. The second
would be to adjust the measured assays to
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creste a new condgstent data set that
satidfies dl the mass bdance equations.
The latter is obvioudy the more desrable
gpproach. Adjustment of the mass balance
data must meet two criteria (i) adl mass
ba ance equations must be satisfied and (ii)
the total adjustment made to the data set
mus be aminimum.

Numerica methods that can be used to
solve the materid baance problem include
Lagrangian Multipliers (Wiegd) and Direct
Search Techniques (Mular). Computer
packages that use the numerica methods
includee MBS (Hockings, 1967, Michigan
Tech), MATBAL (Wegd, 1970,
Internationa Minerds  Corporation),
MATBALZ2 (Laguitton, 1979, CANMET),
ONEBAL (Wiegd, 1979) and BILMAT
(Hodouin, 1980). A materid badance
program has aso been developed at
Virginia Tech udng a commedcad
goreadsheet package. This package is
capable of handling up to 10 nodes, 20
sreams and 5 assays. This Spreadsheet
program is known as TECHBAL.

Procedure for Using Techbal

Sep | — Load Software

1. Make sure that Microsoft Excd (95 or
later) isloaded on your computer.

2. Run Excd and determine whether the
“Solver Add-In" is has been |oaded.
This option should be listed under the

Tools mew in Excd. If you do not
see Solver under this menu, click on
Add-Ins... and sdlect the box next to
Solver Add-In and click OK to

activate the product. If you have
problems, complete directions for
inddling “Solver” are described in the
Excd Help menu.

3. Under the File menu, open the
Techbal xIs spreadsheet from the file
where you have saved the program
You may wish to save this master
Soreadsheet under a subdirectory
where the origind file cannot be
accidentaly deleted.

4. Note that areas in the spreadsheet
where data may be entered are colored
grey. Vaues entered by the user will
appear in blue text. The other regionsin
the gpreadsheet are protected to
prevent accidental deletions.

5. A demondration file cdled “Techbal-
demoxIs’ has been provided to show
how data should be entered in the
Spreadsheet. The information related to
this example is discussed later in these
ingtructions (see bottom of page 5). If
you have not previoudy used Techbd,
you may wish to open this spreadshect
fird.

Sep I - Enter the Flowsheet Connection
Matrix

1. Sdect the MATRIX page of the
goreadsheet by cdlicking on the
appropriate tab at the bottom of the
page. This is the page where you will
enter the information that describes
your particular flowshest.

2. Enter adescription of your circuit in the
areatitted CIRCUIT (Row 6).
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3. Enter the names of the unit operations

(nodes) in your flowsheet benegth the
NODE title bar (Row 9). You may use
up to 10 nodes.

. In the column labeled STREAM, enter

the names of dl of the dreams that
connect the unit operations in your
flowsheet (Column A). You may use
up to 20 different stream names.

. Within the matrix defined by the nodes
and dreams, enter a -1 or +1 to
indicate whether each dream exits or
enters the firg unit operation (node).
The vaue zero (0) should be entered if
the stream does not connect to this
node. Repeat this procedure for dl
other unit operations (nodes) in the
flowshest.

. After entering dl of the information that
describes your flowsheet, check the far
right column. Each stream should now
be identified as aether FEED (stream
that enters the flowsheet), PRODUCT
(stream that exits the flowsheet) or
INTERNAL (Stream that remains
internd to the flowsheet). If these
labels do not agree with your flowsheet
layout, you have incorrectly entered
some of your data in the matrix area.
To assg you in finding errors, the two
rows have been provided at the bottom
of the matrix area labeled JUNCTION
and SEPARATOR. The numericd
vaues in these rows tdl you how many
junctions (two streams in — one stream
out) or separators (one stream in — two
dreams out) are present in  your
flowsheet for each node. A summary

of the stream data is aso provided at
the bottom of the page.

Sep Il — Enter the Experimental Mass
and Assay Data

1. Sdect the DATA page of the

goreadshest by clicking on the
appropriate tab at the bottom of the
page. This is the page where you will
enter the numerical data (mass flow
rates and assays) that describe each
gream in your flowsheet.

. Please note that you do not need to re-

enter a description of your circuit in the
area titted CIRCUIT (Row 6). Thisis
performed automaticaly.

. Enter the names of the assays (eg.,

copper, lead, zinc, ash, Btu/lb, sulfur,
etc) you have peformed for each
dream benesth the MEASURED
VALUES title bar (Row 9). Note that
the firsd entry cdl has dready been
reserved for entering MASS. 'Y ou may
use up to 5 assay vaues to describe
each stream.

. Under the cdl titled MASS, enter the

mass flow rates for each stream. These
vaues may be entered as a true flow
rae (eg., kg/min, tonshr, etc.), as a
measured quantity (e.g., gms, kgs, 1bs,
efc) or as a relative percentage or
fraction of the circuit feed. However,
al vdues mugt be entered under the
same format.

. The numerica vdues for each assay

must now be entered in the matrix
benesath the assay names you entered
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earlier. Normally, these values must be
entered ether as a relative indicator of
mass or heat contained in each stream
(eg., % Cu, % ash, ppm Pb, Btuwlb,
etc.). Note that percent solids is not
appropriate as an assay vaue. Repesat
this procedure for dl dtreams in the
flowsheet.

Sep 1V - Enter the Relative Standard
Errors

1. Sdect the ERRORS page of the

goreadshest by dicking on the
appropriate tab at the bottom of the
page. This is the page where you will
enter the rdative erors for the
experimental vaues pertaining to your
flowshest.

. Once again note that you do not need
to re-enter a description of your circuit
in the area titled CIRCUIT (Row 6).
Thisis performed automatically.

. Enter the rdaive standard deviations

(reported as percentages) for each
experimentally measured (or estimated)
vaue. If these vaues are not known,
you may normadly assume that assays
were measured with a relative standard
deviaion of 1% and mass flow rates
with a rdative standard deviation of
10%. Any mass or assay vadue that
was not known when entered on the
DATA page should have the maximum
relative standard deviation (i.e., 99%).

Sep V - Initiate the Minimization
Routine

1. Return to the DATA page of the

spreadsheet by dicking on the
appropriate tab at the bottom of the
page.

. The minimization routine will run more

quickly if you provide the spreadshest
with initid guesses for the various
experimental values. To achieve this,
amply highlight dl of the mass and
assay vaues, dick the right mouse
button and sdect “copy”.  Now
highlight the same aea beneath the
ESTIMATED VALUES title bar
(located to the right), click the right
mouse button and sdect “pagte’. |If
performed correctly, the totd weighted
sum-of-squares (WSSQ) at the right-
bottom corner of the spreadsheet
should be zero.

. Now bring down the list of spreadsheet

tools by sdecting the “Tools” menu on
the maester header for the Excd
oreadsheet. Under thislist, you should
select the equation solver subroutine by
clicking the item labded “Solver”. If
you do not see the “Solver” option
listed, then you probably did not specify
that this option be loaded when you
origindly inddled Excd. (“Solve” is
not one of the default programs that is
automaticaly loaded when you ingall
Excd.) You should refer to the “Hep”
menu on the master header to obtain a
step-by-step procedure for ingdling
“Solver”.

. Examine the entry titled SET TARGET

CELL inthe “Solver” didog box. This
vaue should be liged as $M$30. This
is the cdl that refers to the totd
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. Examine

weighted sum-of-squares a  the
bottom-right corner of the spreadshest.
If this cdl is not dready selected,
please do so now.

. Examine the entry titted EQUAL TO in
the “Solve” didog box. The
minimization option labeled MIN should
be selected.

the entry titted BY
CHANGING CELLS in the “Solver”
didog box. Use the mouse to highlight
thisrow. Therange of cdls specified in
this entry should correspond to the
matrix of esimated vaues (mass and
assays) beneath the ESTIMATED
VALUES title bar. All of the vaues
that you plan to adjust should be
highlighted.

. Examine the entry titled SUBJECT TO
THE CONSTRAINTS in the “Solver”
didog box. The congraints should be:
$BE3AK$44=0. If thisis incorrect,
click on the ADD or CHANGE button
and modify the condraint to set cdls
within this range to zero. These cdls
are hidden on the DATA page, but
refer to important cadculations on the

WSSQ page.

. Click on the SOLVE button to begin
the minimization process. This may
take a congderable amount of time
depending on the size and complexity of
your flowsheet.

. Once “Solver” finds a solution, select
the OK button to accept the solution.
The best estimates of your mass and
assay values are now located beneath

the ESTIMATED VALUES title bar.
These values represent a consistent and
unambiguous st of flowsheet data.

Sep VI — Evaluate the Minimization
Results

1.

If your data required a dgnificant
amount of adjustment, then one or more
of the vaues in your origina data were
probably unreliable.

The amount of adjustment can be
quaitativdly obsarved by visudly
comparing the your origind data
(MEASURED VALUES) with the
adjusted vdues  (ESTIMATED
VALUES). Alternativdy, you may
examine the caculated relative change
between the measured and estimated
vaues. These vaues are provided on
the ERRORS page under the
RELATIVE CHANGE IN
MEASURED VALUE (%) title bar. A
gndl vadue indicaes that litlle
adjusment was required, while a large
vaue indicates that a large adjustment
was required. A zero indicates no
adjustment occurred.

A rdative change of less than 10% can
normally be accepted for data collected
under typicd plant conditions. Vaues
requiring a larger adjustment should be
examined for rdiability.

You may wish to see if a better fit can
be obtaned by sdecting different
relaive errors for the various streams.
This is normdly a trid-and-error
aoproach that requires a dgnificant
degree of experience.
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M ass Balance Example

The uility of the Techba spreadshest is
best illustrated usng an actua example.
Congder the flowsheet shown in Figure 1
for a combination cod cleaning circuit
incorporating spirds and froth flotation.
Feld data obtained using the flowsheet are
summarized in Table 1.

Sep | — Load Software

Activate the Microsoft Excel application
and load the Techbd spreadsheet. The
blank connection matrix page should
aopear. In order to avoid loosng the
magter copy of the program, you should
save the spreadsheet under a different file
name. Remember that the only areas on the
Spreadsheet where data may be entered are
colored grey. Vaues entered by the user
will gppear in blue text.

Sep |1 - Enter the Flowsheet Connection
Matrix

Sdect the MATRIX page of the
Spreadsheet by clicking on the gppropriate
tab a the bottom of the page. Enter a
description of your circuit (Row 6), the
names of the unit operations (Row 9), and
the names of dl streams that connect the
operations (Column A). Within the matrix
defined by the nodes and streams, enter a—
1 or +1 to indicate whether each Stream
exits or enters each unit operation (node).
The vaue zero (0) should be entered if the
stream does not connect to this node. A
completed copy of the MATRI X page for
thisexampleis shownin Figure 2.

After describing the flowsheet, check
the far right column. Each stream should
now be identified as either FEED (stream
that enters the flowsheet), PRODUCT
(stream that exits the flowsheet) or
INTERNAL (stream that remains internd
to the flowsheet). Two rows have been
provided a the bottom of the matrix area
labeled JUNCTION and SEPARATOR.
The numericd vaues in these rows tell you
how many junctions (two streams in — one
stream out) or separators (one stream in —
two Streams out) are present in your
flowsheet. For the case shown, there are
four product (leaving) sreams and five
interna sreamsin addition to the single feed
gream. All of the unit operations (cyclone,
soird, screen and flotation cdl) ae
correctly idertified as separators, while the
sump is properly identified as ajunction. If
these labels do not agree with your ciruit
layout, you have incorrectly entered some
of your datain the connection matrix area.

Sep Il — Enter the Experimental Mass
and Assay Data

Sdect the DATA page of the
spreadsheet by clicking on the gppropriate
tab at the bottom of the page. Enter the
names of the assays (e.g., ash and sulfur)
for each stream (Row 9) as wel as the
numerica vaues for the assays for each
stream. Next, under the cell titted MASS,
enter the mass flow rates for each stream.
A completed copy of the DATA page for
thisexampleis shown in Figure 3.

Sep 1V - Enter the Relative Standard
Errors



Sdect the ERRORS page of the
spreadsheet by clicking on the appropriate
tab at the bottom of the page. Enter the
relative standard deviations (reported as
percentages) for each experimentaly
measured (or estimated) vaue. If these
vaues ae not known, you may normaly
assume that assays were measured with a
relative standard deviation of 1% and mass
flow rates with a relative sandard deviation
of 10%. The higher the vdue, the less
confidence you have in the measured vaue.

A large error (e.g., 99%) may be entered
for an unknown vaue and smdl error (eg,
0.001%) for values you wish to remain
unchanged. A completed copy of the
ERROR page for this example is shown in
Figure 4.

Sep V - Initiate the Minimization
Routine

Return to the DATA page of the
Spreadsheet by clicking on the appropriate
tab a the bottom of the page. The
minimization routine will run more quickly if
you provide the spreadsheet with initid
guesses for the various experimenta values.

To achieve this smply highlight al of the
mass and assay vaues, dick the right
mouse button and select “copy”. Now
highlight the same aea benesth the
ESTIMATED VALUES title bar (located
to the right), click the right mouse button
and sdlect “paste’. If performed correctly,
the tota weighted sum-of-squares (WSSQ)
a the right-bottom corner of the
spreadsheet should be equa to zero. The
speadsheet should now agppear as shown in
Figure 5.

Drop down the list of spreadsheet tools
by sdecting the “Tools’” menu on the master
header for the Excel spreadsheet. Select the
equation solver subroutine by dicking the
item labded “Solver”. The didog box
shown in Figure 6 should gppear. Examine
the entry titled BY CHANGING CELLS.
Use the mouse to highlight this row. The
range of cdls specified in this entry should
correspond to the matrix of edtimated
vaues (mass and assays) beneath the
ESTIMATED VALUES title bar. All of
the vaues that you plan to adjust should be
highlighted. After sdecting the appropriate
vaues, click on the SOLVE button to begin
the minimization process. After “Solver”
finds a solution, sdect the OK button to
accept the solution.  The best estimates of
your mass and assay vadues are now
located benesth the ESTIMATED
VALUES itle bar. The spreadsheet should
now appear as shown in Figure 7.

Sep VI — Evaluate the Minimization
Results

If your data required a dggnificant
amount of adjustment, then one or more of
the vdues in your origind data were
probably unrdigble or collected under
conditions that were not steady-state. The
amount of adjusment can be quditatively
obsarved by examining the caculated
relaive change between the measured and
esdimated values. ~ These vdues ae
provided on the ERRORS page under the
RELATIVE CHANGE IN MEASURED
VALUE (%) title bar. A relative change of
less than 10% can normdly be accepted for
data collected under typicd plant
conditions. However, the required
accuracy may vary greetly depending on the
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intended use of the data. For the example
shown, the adjusments were dl less than

about 5%, suggesting that this was a
relatively reliable data set.

You may wish to see if a better fit can
be obtained by sdecting different relaive
erors for the various streams. This is
normaly a trid-and-error agpproach that
requires consderable experience.

Problems?

If you have technica questions related
to the operation or application of the
Techbal spreadshest, please contact:

Dr. Gerdd (Jerry) H. Luttrel
Department of Mining & Minerds
Enginering

100 Holden Hall

Virginia Polytechnic Indtitute & State
Universty

Blacksburg, Virgnia 24061

E-Mall: luttrell @vt.edu

User | nfor mation

Techbal may be freely distributed by
commercial or educational organizations
provided that the primary calculation
cells remain unaltered. The authors
provide no warranty related to the
correctness or applicability of the
spreadsheet and assume no liability for
user decisions that may be based on the
spreadsheet output. Microsoft ExcelO is
a registered trademark of the Microsoft
Corporation. The use of Excel should
not imply an endorsement by the author.
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Figure 1. Example of atypical spird-flotation cod cleaning circuit.

Table 1. Field data obtained for the spiral-flotation cod ceaning circuit.

Stream Rate (tph) Ash (%) Sulfur (%)
Circuit Feed 149.0 27.90 0.89
Cyclone Oversize 112.0 26.10 0.71
Cyclone Undersize 37.0 33.50 1.33
Spiral Concentrate 83.0 8.60 0.56
Spiral Rgject 28.0 76.20 121
Screen Oversize 78.0 7.81 0.55
Screen Undersize 4.9 21.40 0.71
Flotation Feed 42.0 32.20 1.25
Hotation Concentrate 26.0 8.10 0.86
Flotation Reject 15.9 71.80 1.71




TECHBAI

- MATFRIAI

RAl ANCF SPREFANDSHFEFT

Author:

G. H. Luttrell

Depariment.  Mining & Minerals Engineering

Address:

Virginia Polytechnic Institute and State University

Blacksbig, Virginia USA 240610258

CIRCUIT: ISgiraI—FIotation Coal Processing Circuit |
Node

Stream Cyclone | Spiral Screen Sump | Flotation Sum Circuit
Circuit Feed 1 0 0 0 0 1 feed
Cyclone O/S -1 1 0 0 0 0 internal
Cyclone U/S -1 0 0 1 0 0 internal
Spiral Conc 0 -1 1 0 0 0 internal
Spiral Tail 0 -1 0 0 0 -1 product
Screen O/S 0 0 -1 0 0 -1 product
Screen U/S 0 0 -1 1 0 0 internal
Float Feed 0 0 0 -1 1 0 internal
Float Conc 0 0 0 0 -1 -1 product
Float Tai 0 0 0 0 -1 -1 product
lJunction 0 0 0 1 0 1
| Separator 1 1 1 Q 1 4
(1=In,-1=0Out,0=No Effect) Number of feed streams: 1 Number of internal streams: 5

Number of product streams: 4 Minimum required samples: 9

Figure 2. Completed MATRIX page describing the plant flowshet.

TECHBRAL _MATEDRIAI BAILANCE SDREADSHEET
Author: G. H. Luttrell Address:  Virginia Polytechnic Institute and State University
\Depariment  Mining & Minerals Engineeting Blackshiug \irginia |ISA 240610258
CIRCUIT: IQnimI-Flmminn Coal Praocessing Circuit I

Measured \/aleg Estimated \/alileg

Stream Mass. Ash % Sulfur % Mas Ash % Sulfur %
ICiccuitFeed - 3 14000 F 2790} 089 _} _ _ _ _} - -} - -} —
ICyrloneOS_ 1 11200 L 260 L 070 _F - -} bbb
ICyclone /S _ 3 2700 | 2370 | 123} _}p -} — - =
R T T e g B 0 g e I e I
Sniral Tall . L 2800 _ L 7620 L 120 L - - _ b o b e e et e e e - o
Screen O/S 78.00 7.81 0.55
Tt T I N B o g e I e I
[Elpatkeed_ _ 1 4200 _ L 2220 L 125 L - o b o b e et e e e e - o
Float Conc 26.00 8.10 0.86
FlpatTail - L JR90_ L 7180 _ L 170 oL - - e e et - - - -

Figure 3. Completed DATA page showing measured mass and assay va ues.

Total WSSO:
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TECHRBAI - MATFERIAI

BRAI ANCF SPREFADSHEFT

Author:

G. H. Luttrell
\Repartment.__Mining & Minerals Enaineering

Address: Virginia Polytechnic Institute and State University

Rlacksburg Virginia USA 240000008 ]

CIRCUIT: ISpiraI-FIotation Coal Processing Circuit

Relative Standard Deviations (%) Relative Change in Measured Value (%)
Stream Mass Ash % | Sulfur % Mass Ash % | Sulfur %
Circuit Feed 10.00 1.00 1.00 -100.00 | -100.00 | -100.00
Cyclone O/S 10.00 1.00 1.00 -100.00 | -100.00 ] -100.00
Cyclone U/S 10.00 1.00 1.00 -100.00 | -100.00 | -100.00
Spiral Conc 10.00 1.00 1.00 -100.00 | -100.00 ] -100.00
Spiral Tail 10.00 1.00 1.00 -100.00 | -100.00 | -100.00
Screen O/S 10.00 1.00 1.00 -100.00 | -100.00 | -100.00
Screen U/S 10.00 1.00 1.00 -100.00 | -100.00 | -100.00
Float Feed 10.00 1.00 1.00 -100.00 | -100.00 | -100.00
[Float Conc 10.00 1.00 1.00 -100.00 ] -100.00 | -100.00
Float Tail 10.00 1.00 1.00 -100.00 | -100.00 ] -100.00
Total WSSQ:| ####H##1
Figure 4. Completed ERROR page showing estimated relative errors.
TECHRAI - MATFRIAI RAI ANCF SPRFEANSHEFT
Author: G. H. Luttrell Address: Virginia Polytechnic Institute and State University
Department: Mining & Minerals Engineering Blacksburg, Virginia USA 24061-0258
CIRCUIT: ISDLLaLEIma.LLQDLQaLELQ&essm.u&LLmLI |
Measured Values Estimated Values
Stream Mass Ash % | Sulfur % Mass | Ash % | Sulfur %
[ Circuit Feed 149.00 27.90 0.89 149.00 27.90 0.89
Cyclone O/S 112.00 26.10 0.71 112.00 26.10 0.71
ICyclone U/S 37.00 33.50 1.33 37.00 33.50 1.33
Spiral Conc 83.00 8.60 0.56 83.00 8.60 0.56
| Spiral Tail 28.00 76.20 1.21 28.00 76.20 1.21
|Screen O/S 78.00 7.81 0.55 78.00 7.81 0.55
|Screen U/S 4.90 21.40 0.71 4.90 21.40 0.71
Float Feed 42.00 32.20 1.25 42.00 32.20 1.25
[Float Conc 26.00 8.10 0.86 26.00 8.10 0.86
Float Tail 15.90 71.80 1.71 15.90 71.80 1.71
Total WSSQ: 0.00

Figure 5. DATA page after cut-and-paste of measured vauesinto estimated cdlls.
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TECHBAL - MATERIAL BALANCE SPREADSHEET

Author: G. H. Luttrell Address: Virginia Polytechnic Institute and State University
Department: __Mining & Minerals Engineering Blacksburg, Virginia USA 24061-0258

CIRCUIT: lSmmLEmmmmLEmnng

Measured Values Estimated Values
ISteam | Mass | Ash% | Sulfur% | Sulfur %
Circuit Feed 149.00 27.90 0.89 0.89
Cyclone O/S 112.00 26.10 0.71 0.71
Cyclor I e 133
Spiral 0.56
Spiral | Set Target Cell: EMEI0 * 121
Screel 0.55
Screel Equal To: CMax  F Min € alue of: IU 071
Floatf By Changing Cels: 125

Float 0.86
Foat 1 |$H$10:47519 = ﬂl o

~Subject to the Constraints:

$E430: SKgd = 0 | add

Change |

Reset All |
ﬂ Delete |

Help |

Total WSSQ: 0.00
Figure 6. DATA pagejust prior to Sarting the Solver search routine.
TECHBAL - MATERIAL BALANCE SPREADSHEET
Author: G. H. Luttrell Address: Virginia Polytechnic Institute and State University
Department: __Mining & Minerals Engineering Blacksburg, Virginia USA 24061-0258
CIRCUIT: bnmLEmmm_Qo.aLEmﬁﬂugﬂmun |
Measured Values Estimated Values
Stream Mass 1 Ash% 1 Sulfur9% Mass 1 Ash % | Sulfur9%
| Circuit Feed 149.00 27.90 0.89 145,11 28.01 0.87
Cyclone O/S 112.00 26.10 0.71 107.28 25.94 0.72.
Cyclone U/S 37.00 33.50 133 37.83 33.89 1.29
Spiral Conc 83.00 8.60 0.56 79.90 8.65 0.56
Spiral Tail 28.00 76.20 121 27.38 76.38 121
Screen O/S 78.00 7.81 0.55 74.75 7.77 0.55
Screen U/S 4.90 21.40 0.71 5.14 21.41 0.71
Float Feed 42.00 32.20 1.25 42.98 32.40 1.22
Float Conc 26.00 8.10 0.86 26.24 8.07 0.88
Float Tail 15.90 71.80 171 16.73 70.54 1.76
Total WSSQ:L_42.09

Figure 7. DATA page after solving for estimated vaues.
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TECHBAL - MATERIAL BALANCE SPREADSHEET

Author: G. H. Luttrell Address: Virginia Polytechnic Institute and State University
Department: __Mining & Minerals Engineering Blacksburg, Virginia USA 24061-0258
circuT:  |Spiral-Flotation Coal Processing Circuit |
Relatjve Standard Deviations (%) Relative Change in Measured Value (%)
Stream | Mass | Ash% | Sulfur% Mass Ash % | Sulfur %
Circuit Feed 10.00 1.00 1.00 -2.61 041 -1.95
Cyclone O/S 10.00 1.00 1.00 -4.22 -0.61 197
Cyclone U/S 10.00 1.00 1.00 2.25 117 -2.69
Spiral Conc 10.00 1.00 1.00 -3.74 0.61 -0.20
Spiral Tail 10.00 1.00 1.00 -2.20 0.24 -0.36
Screen O/S 10.00 1.00 1.00 -4.16 -0.45 -0.25
Screen U/S 10.00 1.00 1.00 4.94 0.03 -0.27
Float Feed 10.00 1.00 1.00 2.32 0.61 -2.07
Float Conc 10.00 1.00 1.00 0.93 -0.31 2.42
Float Tail 10.00 1.00 1.00 5.25 -1.76 3.07
Total WSSO: |_42.09

Figure 8. ERROR page showing percentage changes between measured and

estimated vaues.
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